o primary KeY

Creating a Table; Setting th gn View

Activity 2.3 . :
Field; Modifying Properties 1" Des!

E in UQW.@j
Mww,\,m\:_”:_um_‘:wﬁzm.a creating a table in Datasheet view, you can create mu»w%%; right away-
<<:m.3 ©sign view, you can set the field’s properties the way you :mm<< table automati-
cally, ><0c e Design view, Access does not add the /D field to S.m ns ora field used to
store mm mentioned previously, a table should have a primary ke field, ' mary key field are
those ﬁjcm”_ncm <m_cw for each record. Examples of fields suitable for 2 pr Tt number, a ven-
dor numbes ore an identification value such as an employee number: & P2 esign, you 90
i €r, or a customer number. If, when you are working on @ pbe and set the data
type to >m3< data suited to a primary key field, create a field labeled /D rties group on the
Table Hooh_ho_nz hber, When creating a table in Datasheet view, Em Prope field proper-
ties. In D = _m_nm tab contains buttons and an option for modifying or @ with options for
addi ©sign view, the Field Properties section contains property Doxes

Ng or modifying field properties. -
Worldwi = o the
mzﬁm_.%_.“\w_mm What You Will Do  Rhonda Trask, human resources manager, has asked you 10 éorxﬁ_o store

w330_0<mmm database. Rhonda would like you to create a new table in the file In A and add
e m390<mm benefit plan information. You decide to create this table in Design view
and modify field properties. )

%ﬁ eating a Table in c Open 2-WEEmployees.acedb and enable the contents, if necessary. !
esign View This database is similar to the database you worked with in the Skills Review for
E Section 1. This version of the database has additional records added.
mmw_m‘w‘mzm Primary ° Click the Create tab and then click the Table Design button m in the Tables group-
[ Tutorial 3 ° With the insertion point positioned in the Field Name column in the first row, Q_ﬁm 4
Modifying Field EmployeelD and then press the Enter key or the Tab key to move to the next column.
qﬁ&m:_mm in Design ° With Short Text already entered in the Data Type column, change the default field
size from 255 to 4 by double-clicking the number R .
255 in the Field Size property box in the Field e o -
Properties section and then typing 4.
The EmployeelD field will contain numbers; however,
leave the data type defined as Short Text since
no calculations will be performed with employee
numbers. Notice the information that displays in the
bottom right corner of the Design window. Access
.Q_mb_m.ﬁ Sm.u_‘Bmzo: m_.uoE the field in which the e —"
insertion point is positioned. LEens™—
Click in the Description column to the right of Short Text, type Type the four-digit

employee number, and then press the Enter key to move to the second row.

Type PensionPlan in the Field Name column in the
second row and then press the Enter key.

Click the arrow at the right of the Data Type
column and then click Yes/No at the drop-down list.

In this field, the data is only one of two entries:
Yes if the employee is enrolled in the pension plan

or No if the employee is not.

B Tablel

Name

F m!b_oﬁr_o
| PensionPlan

G i

(it D Bt LR IV
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! % Change the default value from No to Yes s
N e 2 eneral ' Lool
a1 ~te Table in Design by double-clicking No in the Default Value Format_ vesNo
= ; . . . . iCaption ___ B
( Create tah, property box in the Field Properties section P I T R
=2 Cli x = — 7 =S
utctl;Table Design and then typing Yes. "V’m,m:‘f; —
~— Type f % - 05 : fadeud No
gcﬁngfga?: rg,gzs e Click in the Description column to the right of (et Al Genera
! dgssﬁgmmns or Yes/No, type Click or press spacebar for Yes;
0 z
e 3 Properties. g el leave empty for No, and then press the Enter key.
ASSian primary ke A
i Ef-"’- il Enter the remaining field names, data types, and descriptions as shown in
6. Tyggg%‘,’:ggyn%” Figure 2.2 by completing steps similar to those in Steps 3-9. Change the default
7. Click 0K, value for the HealthPlan field to Yes.
™ Assign Prima ; :
Key Field o Click anywhere in the EmployeelD field
i qpen table in Design name. £= insert Rows
[~ lerlew. . ey 3 Delete Rows
3'a c%‘;zlpnmary Key field @ Click the Primary Key button [¥]in the N E:? = b
. Cli i 3 . ¢ L I
— bggl;:nmaw Key Tools group on the Ta?le T09ls Design tab. All Access . @ « |8 T
4. Save table. A key icon appears in the field selector bar iy '° 1 EmD'OYee|Dl\
to the left of EmployeelD, indicating the field A ones PensionPlan
‘ is the primary key field.
. @ Click the Save button on the Quick Access
Toolbar. ﬁ
— m At the Save As dialog box, type Benefits in the Table L W
Name text box and then press the Enter key or click OK. | it
Benefitd .
@ Close the Benefits table. ¥
LA_%_‘ Cancel
Figure 2.2 Design View Table Entries
] Tablel
o FeldName | DataType i o ~ Description (Optional)
‘EmployeelD |Short Text Type the four-digit employee number
PensionPlan Yes/No Click or press spacebar for Yes; leave empty for No
DentalPlan Yes/No Click or press spacebar for Yes; leave empty for No
HealthPlan Yes/No Click or press spacebar for Yes; leave empty for No
Dependents Number Type the number of dependents related to this employee
Lifelnsce Currency Type the amount of life insurance subscribed by this employee

. (0,10 @ (TT g Compare your work to the model answer to ensure tha
Work you have completed the activity correctly. e AT

g In Addition

Using the More Button on the Table Tools

} Fields tab in Datasheet View

\ ick the More Fields button to choose from a list of category allow you to add a group of related fields in

: oy field data types and fields that have predefined one step. For example, click Address to add five new
fields: Address, City, StateProvince, ZIPPostal, and

' field properties. Scroll down the More Fields drop-

- down list to the QuickStart category. Options in this CountryRegion.
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The accuracy of datain a table .
and improveythe accuracy of the data, apPly tered ina ":/ ith th Ivdation 2
rule can be applie e \alid@ data

number. Apply & validation rule to @ fi C olb Fields
the Field Validation group © Table [

box in Design view. A validation
in a field violates the validation rule.

Validation Text property box in Design V!

§ Worldwide What You Will Do Worldwide Enterprises offe”
Enterprises dependents. You will use the Validation putto 2
validation rule and message indicating that Fhe Vobc
than six. The company offers life insurar\ce in a o
employee. You will use field properties IN Design
$200,000 are entered in the Lifelns field.

With 2-WEmployees.accdb open, O

Applyi Validation i
Rﬁ,’;y,f %:tasahle:t‘\(;irew Click Dependents 1n the header row.

Click the Table Tools Fields tab. and then click the Field

' [ . . :dati ou

QEE’V,-',?%:S}SA'?Z;’VOV” @ Click the Validation putton [7] in the Field vValidation grouP

Validation Rule option.

and then click OK.
ge option.

e Type <6 in the Expression Builder text boX
1d Validation Messa,

n button and then click the Fie

an 6 in the

Click the Validatio

Type Enter a number less th
text box in the Enter Validation Message

dialog box and then click OK.

(6]

(7]

0 Click the View button in the Views group
(9]

[10)

Enter Validation Message

Enter @ numi)er Jess than d

to switch to Design view.

Click Lifelnsce in the Field Name column
to display the associated field properties. @

Click in the Validation Rule property
box, type <=200000, and then press the e Yeulto Ok
Enter key. einsce 7 |cumency

Pressing the Enter key after typing the

validation rule moves the insertion

point to the Validation Text property box.

If an invalid syntax error displays, check | sewn woup

your typing. Do not type a dollar sign or | ———fmea T

comma in the validation rule statement. T ————

Also, make sure you have the correct T —

less-than symbol (<) and equals symbol g .

(=) and that the order is <=. . ——

Alﬂﬂm\.—,:‘:ﬁ_,@:“*'

Type Enter a value that is less than or
equal to $200,000 and then press the Enter key.
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Lreate "Validaﬁon Rul
B Qﬂ:ln table in Desig;3

; View,
- Click in fielg row from

. L Whieh yoy wan
t i
Mﬁk rule, 1
HICK I Validation Rule
erty box

i“"fxmtemem
~ 5 Click in Valdation Text
‘ - _?_yrggerly box.
: eI
o s
ﬁ
/-‘\
("&
(—’—
(
'r-g-\

In Addition

Click the Save button.

@ Click the View button in the Views group to switch to Datasheet view

@ Add the following record to the table:

EmployeelD 1003
PensionPlan Yes
DentalPlan Yes
HealthPlan Yes
Dependents 2

Lifelnsce 210000

When you enter 210000 into the Lifelnsce field and then press the Enter key or the Tab

key, Acc
entered in the Validation Text property box.

@ Click OK at the Microsoft Access error message.

ess displays an error message. The text in the error message is the text you

Microsoft Access

L] [

Enter a value that is fess than or equal to $200,000

X

@ Delete 210000, type 200000, and then press the Enter key.

Pensfo?l;la‘r; .7 DentalPlan 5 -He;itﬁﬁl;ﬁ_-;'[)—ép;ndenmf-
2 5_200,0(7)‘0‘90

T Ufeinsce - |Clickto Add >~

m Close the Benefits table.

Check Your
Work

Validation Rule

Compare your work to the model answer to ensure
you have completed the activity correctly. '

’Q Benefits \,
Employeels;
1003
| [ ] N o 5000

Data Check
Limits customer numbers to 1001 through 1099.

- Understanglll’llg Other Types of Field Name
: validation Rules Customero | >1000 And <1100 ! s
i, Validation rules'should be created Credittimit <=5000 Restrits credit fimits to vlues of 5000 or less.
WHEACH po_ls_‘»hs m[:x;%q%?gfaﬁ:qae State "CA" Only the state of California is accepted.
e EH’OFS. e [Ta),. U " ‘ll Al 1 {nite r Canac tsm'
- mngfyimjstrate various ways touse a | Country 'CA" Or “US Only the United States of Canada o §?¢
‘ le to verify data. OrderQty =25 Quantity ordered must be @ minimum Of 29.

A

. ' i
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asks;
Field

Input M

= Creating
Activity 2.5 Formatting a

m mjnmom: iel
hone NUMY~". 4o

) orl
An input mask displays a Uma.ﬂm_‘zﬁ__‘_‘rwmﬁmﬂ_._mmohmﬁ_mb
i ield. For example, an inpu _diqit
A_Mﬂmvmlzw“w:&omﬂmm to the user that a ﬁjﬁMmﬁMm__m data is enté ina field, YO
of all telephone numbers. Input masks ensu =

In addition to specifying the position and a:_,:_ tters, or C
masks that restrict the data entered to digits, QmQ optional.
or not each digit, letter, or character is requiré e
Design view with the /nput Mask property box. peen enter

how the data is displayed in the field after it has

table for
ws\ in the field-

2 . e mmjmzﬁ
orldwide What You Will Do You will create a new field in th .

w t prop
Aumim_ﬁlmmm eligibility dates and include an input mask and format P s M e
fits table 10
i . : o open the Bene
Tutorial Q With 2-WEEmployees.acedb open, op L Insce, type

Creating an Input o :
Mask o Click in the Field Name column in the blank
PensionDate, and then press the Enter key.
ss the Enter key.

0 Change the data type to Date/Time and then pre he format dd-mmm-YY
= . i €
6 Type Type date employee is eligible for pension plan in t

iew.

(example: 31-Dec-18).
3 Benefin) T BeSeRgtion (Optional) \
% Feld Name Data Type the four-digit employee number
M“_m__nosjhm w:mm\ﬂwas M“ﬂ”o.avaa spacebar for Yes; leave empty for nm
DentaiPlan Yes/No Click or press spacebar for Yes; leave empty for N
HealthPlan Yes/No Click or press spacebar for Yes; leave empty for w_o .
Dependents Number ~.<vaszcig.o;mvw:aazai_mﬁan.ﬂh_..““mumav% e .
o . e e _“H“_:._w.ﬁﬁ T plan in the format dd-mmm-yy (example: 31-Dec- 18}
\ \ ; Sl ek
° Click the Save button.
e With the PensionDate field active, click in the Input Mask property box in the Field
Properties section and then click the Build button _M_ at the right side of the box.
Q Click Medium Date at the first Input Mask T
Wizard dialog box and then click the Next W et sk machs oo kot ol >
button.
215-523513-5
The input masks that display in the list in 0 8 the gt Mask 2, chk the B3¢ Lt bt h

the first dialog box are dependent on the
data type for the field for which you are

creating an input mask.

e Click the Next button at the second Input
Mask Wizard dialog box.
This dialog box displays the input mask
code in the Input Mask text box and sets
the placeholder character that displays
in the field. The default placeholder is the
underscore character.
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e

put Mask Wizard
- *-Lpen table in Design
2. Click fn fiefd row.
3. Click in /nput Mask
_ Property box.
Click Build button.
). Click input mask you
- Wantto create.
~ 6. Click Next.
7. Select placeholder
- Character,
8. Click Next.
' 9. Click Finish at the
Egt wizard dialog

i X.
10. Click Save button.

© ® 066

00

; In Addition

| Input Mask Codes
The Input Mask Wizard is

the Short Text or Date/Time data types. For fields with
data types such as Numfber or Currency or for an input
mask for which the wizard does not provide an option,

i
 used input mask codes.

%can create your own by entering the codes directly
y the property box. At the right is a list of commonly

Click the Finish button at the last Input Mask Wizard dialog box to complete the
rty box and then press the Enter key.

entry in the Input Mask prope

Click in the Format property box.
The input mask controls how a date is entered into
the field; however, by default, Access displays dates
in the format m/d/yyyy- To avoid confusion, you
will format the field to display the date in the same
format that the input mask accepts the data.

he right side of the property box
n list.

Click the arrow at t
and then click Medium Date at the drop-dow

General (oclap
Formst
oot Mask
iCaption ___
Defaut vahe
Nahdaton Rt

nd then type Pension Date.

Click in the Caption property box a

Click the Save button and then switch to Datasheet view.

Click in the first field in the Pension Date column in the datasheet.

The input mask __-___-__ appears in the field.

Type 080718.

A beep sounds as you type
the first hyphen are letters.

field.
Type 08jul18 and then press the Enter key.

Notice that you did not have to type the hyphens or
capitalize the first letter of the month. The greater

Lifelnsce " Pension Date S
$200,000.00 08-Jul-18
At
than symbol (>) preceding L in the mask causes
Access to convert the first character to uppercase.

Adjust the width of the Pension Date column to best fit the longest entry.

Close the Benefits table. Click Yes when prompted to save changes to the layout.

Check Your
Work

after 08. The only characters allowed after
the month section of the

L

every character
Notice the insertion point remains in

Compare your work to the model answer to e
you have completed the activity correctly.

Use To restrict data entry to
0 digit, zero through nine, entry is required

only available for fields with
9 |ditorspace,enry sotrequired
IT lette_r, A th_rough Z, entry is required
2 |leterAthrough Z, enry s motrequired
> all characters following are converted to uppercase
] 3 : .g'.‘”‘»‘i.“i ] »-.
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Activity 2.6 Creating a Lookup List

field t0
d into the i
data enteré up ta :
t the “oate. The Loo 2 lookuP f
hat you C reate

: ed to U1~
the options Llfokup settings:

tering the

Create a lookup field when you want to restric
values from an existing table or a list of vaIUQS t
Field Properties section in Design view contains
Access includes the Lookup Wizard to facilitate en acation
Vi A

' le to store cation

: g " v enefits tab st of va
orldwide What You Will Do You will create a new field in the B drop-down “n the list.

g w
i 5 - . a .
Enterprises entitiement for each employee. You want the field t0 dlSF"iyt match items I

periods and restrict the field to accept only those entries tha %
i i iew.
efits table 11 Design Vv

Lookup 0 With 2-WEEmployees.accdb open, open the Ben . nDate, tYP
Field o Click in the Field Name column in the blank row below R
Vacation, and then press the Enter key. lick Lookup Wizard
9 Click the arrow at the right of the Data Type column and then ¢
at the drop-down list.
o At the first Lookup Wizard dialog Lighup Wied mmm;%ﬁgmm‘;m |

box, click the I will type in the
values that I want option and then SRR |, . ooyt e i o0 P
qery. =

click the Next button. £z e ‘
If you press the Enter key by /b' T 7 :
mistake and find yourself at the
next step in the Lookup Wizard,
click the Back button to return to

the previous dialog box.

Click in the blank row below
Coll, type 1 week, and then
press the Tab key.

Type 2 weeks and then press the Tab key.
Type 3 weeks and then press the Tab key.
Type 4 weeks and then click the Next button.

Lookup Wizard
What values do you want to see in your lookup field? Enter the number of columns you want in the
list, and then type the values you want in each cell.

To adjust the width of a column, drag its right edge to the width you want, or double-ciick the
nght edge of the column heading o get the best fit.

Humber of golumns: 1

Colt
1 week
&
wesks
%M
8
R al

Click the Finish button in the last Lookup Wizard dialog box to accept the default
label Vacation. No entry is required in the Description column, ~N
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m m Click the Lookup tab in the Field Properties section and then view the entries made
gg?getlgglt( of Values to each property by the Lookup Wizard.
| il up Wizard y
‘1'&%&" table in Design 0 Click in the Limit To List property box, click the arrow that appears, and then
2, Tsrrpe field name and click Yes.
Dress
¢ angin(tjgr{a type to By changing the Limit To List property to Yes, you are further restricting the field to
- 200RUp Wizard, only those items in the drop-down list. If someone attempts to type an entry other than
a ﬁ' ﬁgg'é; glltype in the 1 week, 2 weeks, 3 weeks, or 4 weeks, Access will display an error message and will
5. Cliek Nex‘tq. et not store the data.
6. Type field values in
Coli colymn,
7. Click Next.
8. Click Finish.
9. Click Save,

e

Click in the Allow Value List Edits property box, click the arrow that appears, and
then click No.
You want to make sure that changes to the list that you created are not allowed by
someone using the table or a form.

Click the Save button and then click the View button to switch to Datasheet view.

If necessary, scroll right in the table, click in the first field in the Vacation column,
type 6 weeks, and then press the Enter key.

Click OK at the message that displays informing you that the text entered isn’t an
item in the list.

Click 3 weeks at the drop-down list and then press  [Peraenpate 7 Vacaron o1
the Enter key. :

Display the table in Print Preview. Change to
landscape orientation and then print the table.

Close the Benefits table.

(o] -1/ @ (ITT  Compare your work to the model answer to ensure ft
Work you have completed the activity correctly. b

© © 6 6 66

In Addition

Looking Up Data from Another Table

ltems in a drop-down list can also be generated by store, and assign a label to the column. Creating field
specifying an existing field in another table or query. entries using this method ensures that data is consis-
To do this, click the Next button at the first Lookup tent between tables and eliminates duplicate typing of
Wizard dialog box to accept the default setting / want information that can lead to data errors. For example,
the lookup field to get the values from another table or in a database used to store employee information, one

query. In the remaining wizard dialog boxes, you choose  table could be used to enter employee numbers and
the table or query and the field you want to use, choose  then the remaining tables look up the employee number
the sort order for displaying the field values, adjust the by scrolling a list of employee names.

column width for the lookup list, select the value to
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Activity 2.7 Managing Fields; Formatting
Inserting a Total Row

perform mogt
: Design View,
i Datasheet
ina table 1N
g r(Ij: tElc;me tab. Use the Totals
t to a datasheet and th?ann—
m minimun, count, S

rozen

or f
den, tab. In

Flelds in Data h dele hid
sheet vie n i rt m eleted, Ni
W can be inserted, moved, ! the Home

ff::l,gsnt]:zr,—],agefnem tasks with buttons in the Records group on

view with buenmserted’ moved, and deleted. Apply formatting t

button in the :ns and options in the Text Formatting group on

choose from ecords group on the Home tab to add a total row

dard deviati a list of _functlons to find the sum, average, maximu
10N, or variance result in a numeric column.

of the Employe€s table In

WOI 'dWlde What You W
u ill Do Y i
O ructure a
u will make Changes to the st u o table, ~d then add

Enterprise
S :
Datasheet view and Design view, apply formatting to the da
m the amounts in the AnnualSalary column.
n Datasheet VieWw.

total row and sy

o With 2-WEEmployees.accdb open, open the Employees table i
| X teus !
v Speliing |

"/.’ahaf;,rf.g Fields in
Datasheet View ~: . ' >
A o Click the Middlelnitial field column heading. oo~ . [ CHER

0 . E P23 ptresh o SSiMoe |
Managing Fields in Click the Delete button [z in the Records group on  fere - X%
De::gn View the Home tab. relords ~
 Tutorial o A_[ the message asking you to confirm the deletion,
click Yes.

Formatting Table Data
Select the Department field column by clicking the
7‘

Department column heading.

Inserting a Total Row
Position the mouse pointer in the Department column heading (make sure the

mouse displays as a white arrow); click and hold down the left mouse button, drag
the thick, black, vertical line to the left so it is positioned between the EmployeelD

and LastName field columns; and then release the mouse button.
When you release the mouse button,
the Department field column is

]

moved between ——
the EmployeelD TR el Bt 0]
e cmployee € = 5 2 . - -
and LastName field 1000 Vektering  Sam 2/18/1960  7/22/2006{Noeth Amedcan Distrilbution
I 1003 i Celesta 31211978 8/5/2005 North Adiedican Distribution
columns. 1005 Deptulsti  Roman 3/12/1959  8/15/2006/Ouersess Distribution

o Click the View button to switch to Design view.
Even though the Department field column was moved in Datasheet view, the field

remains in its original location in Design view.
Select the AnnualSalary field row by positioning the mouse pointer on the field selector

bar to the left of AnnualSalary field row and then clicking the left mouse button.

Position the mouse pointer (white arrow) in the field selector

bar for AnnualSalary field row; drag the black, horizontal line
up so it displays between the BirthDate and HireDate field row;

and then release the left mouse button.

@ Click in a field in the Department row.
m Click the Insert Rows button [£=]in the Tools group on the Table Tools o
A new blank row is inserted above the Department field row.
{
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fE’ Delete Field i
D € Field in

iSheet View
1. Click fielg name in
Neader row,

2. Click Delete button.
gcm:k Yes.

Delete Field i

Vi, in Design

1. Select field row.

2. Click Delete butt
3. Click Yes, A

Insert Field in Desi
View esign

1. M.ake. field active that
Will display after new
field.

2. Click Insert Rows
button.

Move Field in

Datasheet View

1. Click field name in
header row.

2. Diag vertical line to
REW position and then
release button,

Move Field in Design

View

1. Select field using field
selector bar.

2. Drag herizontal line to
new position and then

Insert Total Row

1. Display table in
Datasheet view.

2. Click Totals button.

@ With th

®© 6 06 06

release mouse button.

In Addition

Working with Wide Tables
When working in a table with many columns, scrolling

right can make relating to the record in which you need
to make a change difficult, since descriptor field columns
_such as EmployeelD or LastName may have scrolled

Supervisor an
Text data type.)

down list.

© &

column heading.

06

Click the Save button and then click the View
button to switch to Datasheet view.

Click the Font option box arrow in the Text
Formatting group on the Home tab, scroll down
the drop-down list, and then click Candara.

Click the Font Size option box arrow in the Text
Formatting group and then click /2 at the drop-

Click the Alternate Row Color button arrow in
the Text Formatting group and then click the Tan,
Background 2 color option (third column, first row
in the Theme Colors section).

Click the Gridlines button [ -] in the Text Formatting
group and then click Gridlines: None at the drop-down list. fai

Select the EmployeelD field by clicking the EmpoyeelD [

e insertion point positioned in the Field Name column for the new row, type
d then press the Enter key. (Access will automatically assign the Short

b.( pr‘ﬁm e ‘i_— u
pem  Citgn 5
4 r Californian FB

T Calisto MT

; 't Cambria

-2

b-==n= @& BB

Text Formatbog
> K EE

halSalary ~ Supeivisor l"-‘[‘ ERESw

£9,725.00

Yext Formatng 117 Gridlines: Both
Gridlines: Horizontal

Gridlines: Vertical
72,750.00
88,650.00 Gridlines: None
45,651.00 )

Click the Center button in the Text Formatting group.
Click the Totals button in the Records group on the Home tab.

Access adds a row to the bottom of the table with the label Total at the left.

Click the arrow that appears
at the left, click Sum at the
drop-down list, and then
click in any field in the table
to deselect the total amount.

00

The sum $7,763,808.00 appears at the bottom of the AnnualSalary field column.

006

the table.

Click in the field in the Total row in the AnnualSalary column.

093
1095

Total

Vaquez s
North American Distributior Kilarney Patrick

TGIT979 145/301% SILT77-00
2271988  12/12/2014 7[2.177.00
-

[

Automatically adjust the width of the Department column to best fit the longest entry.

Display the table in Print Preview, change to landscape orientation, and then print

@ Close the Print Preview window and then close the Employees table. Click Yes
when prompted to save changes.

€D Click the File tab and then click the Close option.

Check Your
Work

Compare your work to the model answer to ensure ﬂlat
you have completed the activity correctly. Y

i

off the screen. To alleviate this problem, you can freeze
columns so they do not disappear when the datasheet
is scrolled right. To do this, select the columns you want
to freeze, click the More button in the Records group on
the Home tab, and then click Freeze Fields.
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